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Starting INOVATE
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To begin working with INOVATE as quickly as possible, follow the instructions in this 
chapter.

In this chapter:
• System requirements

• What you need to know to work with INOVATE

• Installation

• Starting INOVATE

• Navigating the system

• Exiting INOVATE

• Getting help and other information
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System Requirements
To run INOVATE, you need the following:

• A Pentium® or faster CPU.

• Windows 2000, Windows 98,  or Windows NT.

• 128 MB of RAM or higher preferred.

• 200 MB of hard disk space. (Typical installation will require 195 MB.)

• A 256 color VGA display.  INOVATE works with display adapters that produce 24-bit 
color.  OpenGL accelerator recommended.

• A CD-ROM drive.

What You Need to Know to Work with 
INOVATE
In the world of 3D design software, INOVATE is unusually clear and simple to operate.  It 
isn’t necessary to learn numerous abstract concepts or acquire diverse technical skills to work 
with INOVATE.

Of course, you need to be familiar with the graphic user interface for your version of Microsoft 
Windows.  If you work with a word processor, spreadsheet or other mainstream application 
program, your knowledge of the user interface is probably sufficient to begin using INOVATE.  
However, if you’re not accustomed to working with a mouse, windows, icons, and the other 
elements of a graphic environment, refer to the tutorial or reference manual for your operating 
system.

Installation
Installing INOVATE under Windows 2000, Windows 
98, and Windows NT
Make sure no programs are running on your system.  If you use an anti-virus program, disable 
(turn off or exit) it before beginning the INOVATE install process.  You can re-enable the anti-
virus and other programs after the INOVATE installation is complete.

Microsoft Windows NT 4.0 specific install notes:
1. You must have NT 4.0 Service Pack 3 or higher installed before installing INOVATE.  

Also, NT 4.0 service packs should be reinstalled after any application is installed, 
including INOVATE.  NT 4.0 service packs are available at:                                               
http://www.microsoft.com.

2. You must login to Windows NT as Administrator to perform the INOVATE 
Installation.
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To install INOVATE under Microsoft Windows 2000, Windows 98, and 
Windows NT:

1. Insert the INOVATE CD into your CD-ROM drive.

The InnovationSuite Setup dialog box is displayed automatically if your CD-ROM 
drive is set to auto-run. Select the icon for INOVATE, to begin the installation process.

If the Setup dialog box is not displayed, select the Start button on the Windows task bar 
and then select Run.  In the Open field, enter the following command using the letter of 
your CD-ROM drive.  For example:  d:\ Initiator.exe.

2. Follow the installation instructions.

Starting INOVATE
As with installation, the procedure that you use for starting INOVATE is the same for 
Windows 2000, Windows 98, and Windows NT.

To start INOVATE under Windows 2000, Windows 98, and Windows 
NT:

1. On the Windows task bar, click the Start button.

2. On the task menu, select the Programs option.

3. On the Programs menu, select InnovationSuite to display a cascading menu.

4. From the cascading menu, select INOVATE.

The INOVATE opening screen appears.

After the INOVATE opening screen, a dialog box appears asking the user if they would like to 
register the product now. If the user decides not to register at this time, the product will run for 
30 days after which time it will need to be registered to continue. If the user decides to register 
the product, a activation wizard will open to walk the user through the process of registering 
the product for the current machine. The serial number  and codeword shipped with the product 
is used along with the users information to create a activation code that will be email back to 
the user.The registration process can be completed by sending information to IronCAD, LLC 
through the web or by fax.

INOVATE will start with a blue-grid scene, allowing the user to begin right away. If you wish 
to create a new scene, follow the instructions below.

To create a new scene:
1. Choose Create a new Scene to begin a new project.

2. Choose OK.

The New dialog box appears.

3. On the New dialog box, choose the scene tab that best fits the type of work you do, 
then select one of the scene templates.

If you’re not sure which template type or scene template to choose, select the Blank 
Scene template from the Workspace (English) tab.

INOVATE displays a blank 3D scene.  Now you’re ready to begin working in INOVATE.

Note

To conserve disk space, you can 
omit some catalogs from the 
installation process.  Once you 
install INOVATE, you can 
access these catalogs directly 
from the CD-ROM.
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Navigating the System
Since you’re familiar with Microsoft Windows, you already know how to use most elements of 
the INOVATE interface.  Much of your work in INOVATE involves standard Windows 
techniques in its scene environment:

• Drag-and-drop object placement.  Use this technique to build a part by choosing items 
from catalogs.  You also can edit the components of a part or drawing view using the drag-
and-drop method.

• Pop-up menus.  Most elements of the INOVATE environment include pop-up menus of 
unique options.  To display the pop-up menu for an item, right-click the item -- that is, 
click it once with the right mouse button.

• Properties sheets.  Like pop-up menus, nearly all items in INOVATE have properties 
sheets.  These dialog boxes facilitate such operations as customizing the features of a part  
in INOVATE.  The properties sheet for an item is accessed through its pop-up menu.  

The remainder of this section introduces the unique features of the INOVATE interface.  Once 
you’re familiar with the basic concepts and techniques in this section, you can move on to the 
next chapter and learn how to build a part.

The INOVATE Window
When you open an INOVATE scene, you see its associated main window and those 
components listed below that are associated with the scene environment:

• 3D Scene. This is the workspace for 3D part design in the scene environment.

• Menus.  INOVATE’s default main menu bars provide access to most of the scene 
commands in INOVATE.  INOVATE’s menus are, however, fully customizable.

• Toolbars. INOVATE’s default scene toolbars provide options for working with files, 2D 
and 3D graphics, drawing tools, and other important features of INOVATE.  Like menus, 
INOVATE’s toolbars can be customized, as desired.

• Catalog.  Catalogs are available in the scene environment and are groups of related 
resources such as parts and surface finishes.  To use catalog items in your part design 
projects, simply drag and drop their icons into the scene.

• Scroll bar and navigation buttons. Use the scroll bar to move through catalogs or to 
browse their contents.

• Tabs.  To display a particular catalog, select its tab.

• Status bar.  Use this space at the bottom of the window to view informative messages and 
tips about INOVATE.  The right side of the status bar shows the current unit of 
measurement and the time.

Menus
Most of the default main menus follow conventions widely used in desktop software.  For 
example, if you have more than one scene open, you can switch between them using the 
Window menu.

You can access detailed descriptions of all menu options in the INOVATE On-line Help 
system.
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In addition to the main menu bar, many elements of INOVATE have pop-up menus.  
Right-click on the element to display a pop-up menu with commands related to the selected 
element.

Toolbars
The toolbars available in the INOVATE scene environment are:

• Standard•  3D Dimensions

• Selection•  2D Technical Drawing

• Text Format•  2D Constraints

• Camera•  2D Editing

• IntelliShape Creation•  2D Construction

• SmartPaint•  Face/Edge Edit

• SmartMotions•  Assembly

• Camera Picker•  TEAMVAULT

You can choose the toolbars that appear in the INOVATE display.  

To display a toolbar:
1. Choose Toolbars from the View menu or right-click on any currently displayed 

toolbar.

2. On the Toolbars dialog box or the drop-down menu, check the box beside the 
name of the toolbar you want to display.

To hide a toolbar, clear its checked box.

3. Choose Closein the dialog box.

Here are two of the toolbars in INOVATE: IntelliShape Creation and Camera.  

IntelliShape Creation toolbar (Scene)

Camera toolbar (Scene)

INOVATE’s toolbars will help you implement many scene functions easily and quickly.  

Moving and Resizing a Toolbar
When you first start INOVATE, the toolbars may appear across the top, down the left side, and 
across the bottom of the workspace.  They don’t have to remain in these default locations, 
however.  You can position them anywhere in the INOVATE window.

To move a toolbar, use the mouse to drag it to a new location.
Drag a toolbar by left-clicking its background between the available options and moving it to a 
new location.  If you drop it near an edge of the INOVATE window, it appears as a horizontal 
or vertical strip.  If you drop it over a sheet or scene, it appears as a palette that “floats” over the 
workspace.

To resize a floating toolbar, drag one of its corners.
Click and drag the corner to display an outline of the toolbar’s new shape.  Drop the toolbar 
when the desired shape is displayed.

Note

The convention of right-clicking 
is used throughout INOVATE.  In 
addition to revealing pop-up 
menus, you can use right-clicks 
to position or copy a part.

Note
Move a toolbar anywhere in the 
INOVATE window.
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Catalogs
The INOVATE scene environment includes the following default catalogs installed on your 
hard drive:

• Shapes.  This catalog contains IntelliShapes, the building blocks for parts.  Some 
IntelliShapes are basic 3D solids, such as blocks and spheres and some are holes for 
removing portions of solids.

• Advanced Shapes.  This catalog contains IntelliShape primitives that allow the user to 
customize a shape’s appearance by editing a set of variables.

• Tools.  This catalog contains a set of parameterized IntelliShapes created using the OLE 
automation capabilities within INOVATE.  They present the user with an input dialog for 
customization.

• Animation. This catalog contains motion effects to use to animate your parts.

• Surfaces. Obsidian, Rubber, and Shiny Blue are a few of the items in this catalog that can 
be dragged and dropped onto parts and shapes in the scene.

• Textures.  Use a variety of textures, such as Marble, Chrome, or Wood to add realism to 
part surfaces or interest to the scene background.

• Bumps.  The items in this catalog are used to add bump textures to surfaces of shapes or 
parts.

• Colors.  This catalog provides surface colors to be added to shapes or parts.

• Metals.  Use the items in this catalog to add metallic surfaces to shapes or parts.

• Patterns.  The contents of this catalog are used to add patterns to the surface of shapes or 
parts.

• Stone.  Add a stone finish to the surfaces of shapes and parts with items from this catalog.

• Wood.  From this catalog you can add a wood finish to the surface of shapes and parts.

• Fabric.  This catalog provides fabric surface finishes for shapes and parts. 

• Decals.  Use the items from this catalog to add decal images to part or shape surfaces.

Many other catalogs, including specialty catalogs, are available on the InnovationSuite CD-
ROM.

You can work with the default catalogs installed on your hard drive or any supplementary 
catalogs available on the CD-ROM.  The advantage of working with catalogs on the CD is that 
it saves hard disk space.  Of course, when you want to access a catalog on the CD, the CD must 
be in your drive.  If you work with a particular catalog frequently, you may want to copy its 
contents to your hard disk.  You can reserve the CD for rarely-used items and experimentation.

Saving Your Work
When you’re finished working in INOVATE, or ready to move on to another project, save your 
work.  INOVATE stores all the scene components and all their associated properties in a single 
file.

To save new work in a file:
1. From the File menu, choose Save As.

INOVATE prompts you for the name of a file.

2. Select the directory where you want to save the file, if different from the directory 
that is displayed.
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3. Enter a descriptive title for the file name and choose Save.

INOVATE saves your work in a file with this title.  Unless you specify a different 
extension, INOVATE appends the extension .ics to a scene file.

The next time you save your work, choose Save from the File menu instead of Save As.  
INOVATE uses the existing name for the file.  The only time you would use the Save As 
option with an existing file is to make a copy with a different name.

Exiting INOVATE
When you’re finished working with INOVATE and have saved your work in a file, close the 
program and return to Windows.

To exit INOVATE, choose Exit from the File menu.
You will return to Microsoft Windows.

Getting Help and Other Information
When you have a question regarding INOVATE, there are a number of resources available for 
answers.  Read the remainder of the Getting Started Guide for examples that introduce 
some of the most important features of INOVATE.  In addition, the INOVATE On-line 
Help system contains thorough, task-oriented descriptions of nearly every INOVATE feature.

Tooltips
Use Tooltips to view the label 
for a button on a toolbar.

In addition to the manuals, INOVATE itself offers on-line help in several forms.  For instance, 
if you aren’t sure about the functionality of a toolbar option, you can find out very quickly.

To display the name of a particular tool, point to it.
INOVATE displays a Tooltip, a small box with the name of the tool.  If you’d rather not 
display Tooltips, it’s easy to disable them.

To disable Tooltips display:
1. From the View Menu, select Toolbars.

2. On the Toolbars dialog box, clear the Show Tooltips box, then choose OK.

The Help Tool
It’s easy to get information about other elements of the INOVATE environment, as well.

To display information about a feature in the INOVATE window, click 
the Help tool, then click the feature.
INOVATE opens its on-line help system and displays the requested information.

Browsing the Help System
For information on INOVATE concepts and tasks, refer to the On-line Help system.

To view a list of Help topics, select INOVATE Help from the Help 
menu.
INOVATE displays a tri-pane window with Contents, Index, and Search tabs for its 
Help system displayed on the left and the INOVATE  Welcome screen on the right.  Click 
on the icon to the left of a topic on the Welcome screen or on a topic in the Contents for 
information on it.

Note
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If you don’t see the topic you want in the Contents or on the Welcome screen, look for it 
by name by clicking the Index tab to display a complete listing of topics and subtopics.  Or 
click the Search tab to define search criteria for locating a topic.

INOVATE Technical Support 
For questions about technical support options, please contact your authorized your authorized 
Channel Partner or IRONCAD, LLC.

INOVATE Web Site
Visit INOVATE’s web site at www.ironcad.com for up-to-the-minute information about 
INOVATE.  Our web site is frequently updated with the latest product and support 
information.
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